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Preface

INTRODUCTION
This chapter contains general information that will be useful to know before using the 
EVB-LAN8770M_MC Evaluation Board. Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes the setup and use of the EVB-LAN8770M_MC hardware and 
software, and how to optionally reprogram the preprogrammed on-board 
microcontroller. 
The manual layout is as follows:
• Chapter 1. “Overview” – Shows a brief description of the EVB-LAN8770M_MC.
• Chapter 2. “Getting Started” – Provides information about setup and operation 

of the EVB-LAN8770M_MC.
• Chapter 3. “Hardware Configuration” – Includes information about the 

hardware configuration of the EVB-LAN8770M_MC.
• Appendix A. “Schematics” – This appendix shows the EVB-LAN8770M_MC 

schematics.
• Appendix B. “Bill of Materials” – This appendix includes the 

EVB-LAN8770M_MC Bill of Materials.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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• Appendix C. “Silk Screens” – This appendix includes the EVB-LAN8770M_MC 
silk screen.

• Appendix D. “PIC® MCU Programming” – This appendix includes instructions for 
users who wish to reprogram the EVB-LAN8770M_MC with modified initialization 
code.

CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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WARRANTY REGISTRATION
Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending the Warranty Registration Card entitles users to receive new product updates. 
Interim software releases are available at the Microchip web site.

THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of
interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows Inte-
grated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and 
PIC-kit 2 and 3.

www.microchip.com
www.microchip.com
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CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revisions Section/Figure/Entry Correction
DS50002979A 

(04-17-20)
Initial release

http://www.microchip.com/support
http://www.microchip.com/support
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Chapter 1. Overview

1.1 INTRODUCTION
The EVB-LAN8770M_MC evaluation board is a 100BASE-T1 (single-pair Ethernet) to 
100BASE-TX (Fast Ethernet) media converter that is used for evaluating the LAN8770 
100BASE-T1 Ethernet transceiver.
The 100BASE-TX side of the EVB-LAN8770M_MC uses a KSZ8081MNX transceiver 
and a conventional RJ45 jack with integrated magnetics. It features auto-negotiation 
and auto-crossover.
The 100BASE-T1 side uses a LAN8770M transceiver with a 2-wire, screw-down termi-
nal block. The board also has footprint for a 4-pin connector in place of the terminal 
block. The LAN8770M is configured in reverse MII mode, and connects directly to the 
MII interface of the KSZ8081MNX.
Software is provided to allow users to access the LAN8770 registers from a PC via the 
USB port and an on-board PIC® microcontroller. The board is powered from the USB 
port.
This document describes setup and use of the hardware and software. It also explains 
how to optionally reprogram the preprogrammed on-board microcontroller. A simplified 
block diagram of the board is shown in Figure 1-1.



EVB-LAN8770M_MC Evaluation Board User’s Guide

DS50002979A-page 8  2020 Microchip Technology Inc.

1.2 BLOCK DIAGRAM

FIGURE 1-1: EVB-LAN8770M_MC BLOCK DIAGRAM

1.3 REFERENCES
Concepts and materials available in the following documents may be helpful when 
reading this document. Visit www.microchip.com for the latest documentation.
• LAN8770 Data Sheet
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Chapter 2. Getting Started

2.1 PHYSICAL SETUP
The Microchip EVB-LAN8770M_MC media converter is simple to set up, as shown in 
Figure 2-1.
1. Verify that jumpers are installed on headers J6 and J11.
2. To configure the 100BASE-T1 port as slave, install a jumper on header J3. To 

configure it as master, do not install the J3 jumper.
3. The board is powered via a micro-USB cable.
4. A CAT-5 Ethernet cable can be connected to the RJ45 jack for 100BASE-TX.
5. For 100BASE-T1, connect the single twisted pair cable to the screw terminal J9.

FIGURE 2-1: EVB-LAN8770M_MC EVALUATION BOARD CONNECTIONS

No further steps are needed for the board to pass Full-duplex 100 Mbps traffic between 
the two ports. Note that the CAT-5 port must be linked at 100 Mbps, and not 10 Mbps. 

2.2 EVB-LAN8770M_MC CONFIGURATION TOOL SOFTWARE
The optional EVB-LAN8770M_MC Configuration Tool Software is available to monitor 
and configure the LAN8770M transceiver. Microsoft® .Net 4.5 or a newer version must 
be installed on the PC. The software comes as an executable (.exe) file for 
Windows®operating systems, and no installation is required. To run it, double click the 
file.
The PIC microcontroller on the board is running as a communications device class 
(CDC) device, so it sets up a serial communication port on the PC.
Once the software is started and the application window has opened, select the appro-
priate COM port for the evaluation board, and click the Connect button as shown in 
Figure 2-2.
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FIGURE 2-2: COM PORT SELECTIONS

The initial condition is a blank form with all values filled in with zero. Click the Read but-
tons to update the registers. With a successful connection to the board, you should be 
able to:
• Read and write the SMI Control and Status Registers (Bank 0).

FIGURE 2-3: SMI REGISTERS READ AND WRITE
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• Read and write the Miscellaneous Registers (Bank 1).

FIGURE 2-4: MISCELLANEOUS REGISTERS READ AND WRITE

If you use the Write buttons in the above figures, the whole buffer with all page-values, 
except the Read Only values, is written to the device. This enables you to alter more 
than one word at a time.
Single READ, WRITE, or READ MODIFY WRITE commands are easily accomplished 
using the controls highlighted in Figure 2-5.

FIGURE 2-5: INDIVIDUAL REGISTER COMMANDS
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The PHY Address is copied from the general setup field (PHY ADDR (hex)).
For the READ command, select the appropriate SET value (register bank), and an 
address. After clicking the Read button, the value is displayed into the Clear Console 
window as shown in Figure 2-6.

FIGURE 2-6: SINGLE REGISTER READ COMMANDS

The Read Status button gives quick access to the following status information for the 
100BASE-T1 port:
• Link Up/Down
• Master/Slave
• Local Receiver Status
• Remote Receiver Status
• DSP Bit Error Rate
After clicking the Read Status Cont button, these status information are read every 
200 ms, and this function stops automatically when another read or write operation is 
requested.
The Load Script buttons lets you load three different scripts to execute when the 
appropriate Execute button is clicked. Script execution is displayed in the Clear 
Console window.
Commands supported inside the script are:
• Blank Lines
• # Comment Lines
• Sleep command
• r - Read command
• w - Write command
• RMW - Read-Modify-Write command
The script has to be in a .txt format. All commands are lowercase letters. The sleep 
command is followed with a sleep time in [ms] as a decimal value. All other values for 
the address and data fields have to be provided in hexadecimal with a leading 0x.
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EXAMPLE 2-1: EXAMPLE OF SUPPORTED COMMANDS

#this is a comment line

rmw afe 0x00 0x0518 0x3FF8

w dsp 0x34 0x0001

w pcs 0x00 0x7FFF

w smi 0x17 0x0080

rmw smi 0x10 0x0000 0x0040

rmw afe 0x0B 0x000A 0x001E

w dsp 0x25 0x23E0

sleep 500

r smi 0x01
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Chapter 3. Hardware Configuration

3.1 HARDWARE CONFIGURATION OPTIONS
Figure 3-1 shows the top view of the EVB-LAN8770M_MC evaluation board.

FIGURE 3-1: EVB-LAN8770M_MC REV B (TOP VIEW)

3.1.1 Jumpers and Headers
Section 2.1 “Physical Setup” describes the basic setup of this media converter 
board. When configuring the board, it has to be decided whether it will be set up as a 
100BASE-T1 master or a 100BASE-T1 slave. This is determined using the J3 jumper. 
100BASE-T1 links must always be statically configured with one end as a master and 
the other end as a slave. If both ends are the same type, the connection will not work.
Table 3-1 lists the descriptions of the jumpers, and Table 3-2 lists the header descrip-
tions.

TABLE 3-1: JUMPER DESCRIPTIONS
Jumpers Description

J3 Master/Slave mode selection. Open for master. Closed for slave.
J6 In-line jumper on the VBAT power rail for VBAT current measurement. 

Always close it for operation.
J11 In-line jumper on the USB 5V power rail. It must be closed when the board 

is powered from USB.
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3.1.2 Status LEDs
Descriptions of the status LEDs are shown in Table 3-3.

3.1.3 100BASE-T1 Connector
The board comes with a screw terminal connector for the single twisted pair cable. 
Optionally, the screw terminal can be removed, and a Molex® Mini50 2 mm 4-pin jack 
can be installed. See the Bill of Materials (BOM) for component J8.

3.1.4 Reset Push Button
The SW1 Reset push button resets the PIC microcontroller, which in turn resets both 
transceivers.

TABLE 3-2: HEADER DESCRIPTIONS
Headers Description

J4 These signals are controlled by the PIC microcontroller. They should not be 
controlled externally, but they may be monitored.
Pin 1: MDC
Pin 2: MDIO
Pin 3: KSZ8081 Reset
Pin 4: LAN8770 Reset
Pin 5: Ground

J5 These signals are either controlled by the PIC microcontroller or outputs of 
the LAN8770. Do not drive them externally.
Pin 1: WAKE_IN - Input to the LAN8770
Pin 2: INH - Output from the LAN8770

J14 5-pin PIC programming header

TABLE 3-3: LED DESCRIPTIONS 
LEDs Description

D1 “VDD Main” = 3.3V power, green
D2 “Speed” indicates KSZ8081 100 Mbps (off is 10 Mbps), yellow
D3 “Activity” indicates KSZ8081 traffic, green
D4 “Link” is driven by the LAN8770M dual-function LED/IRQ_N pin. By default, 

this pin is IRQ_N (interrupt) output. For LED indication of link status, the pin 
function must be changed via register write. Green

D6 “LED0” indicates that the PIC microcontroller is programmed, green
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A.1 INTRODUCTION
This appendix shows the EVB-LAN8770M_MC schematic diagrams.
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FIGURE A-1: EVB-LAN8770M_MC SCHEMATIC (1/2)
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FIGURE A-2: EVB-LAN8770M_MC SCHEMATIC (2/2)
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EVB-LAN8770M_MC
EVALUATION BOARD

USER’S GUIDE

Appendix B. Bill of Materials

B.1 INTRODUCTION
This appendix contains the EVB-LAN8770M_MC Bill of Materials (BOM).
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TABLE B-1: EVB-LAN8770M_MC BILL OF MATERIALS
Item Qty Designator Description Populated Manufacturer Manufacturer Part Number

1 23 C1, C6, C8, C9, C11, C12, C13, C14, 
C17, C20, C23, C27, C31, C37, C38, 
C39, C40, C41, C44, C46, C47, C49, 
C50

CAP CER 0.1uF 50V 10% X7R SMD 0402 YES TDK Corporation C1005X7R1H104K050BB

2 12 C2, C7, C10, C15, C16, C18, C24, 
C26, C30, C42, C45, C48

CAP CER 1uF 35V 10% X5R SMD 0402 YES Murata Electronics North America GRM155R6YA105KE11D

3 4 C3, C25, C35, C43 CAP CER 10UF 25V 20% X5R SMD 0603 YES Murata Electronics North America GRM188R61E106MA73D

4 4 C4, C5, C22, C28 CAP CER 18pF 50V 5% C0G SMD 0402 YES Murata GRM1555C1H180JA01D

5 2 C19, C21 CAP CER 0.1uF 250V 10% X7T SMD 0805 YES TDK Corporation C2012X7T2E104K125AA

6 1 C29 CAP CER 4700pF 100V 10% X7R SMD 0805 YES TDK Corporation C2012X7R2A472K

7 3 C32, C33, C34 CAP CER 4.7uF 35V 10% X5R SMD 0603 YES Murata Electronics North America GRM188R6YA475KE15D

8 1 C36 CAP CER 1000pF 50V 10% X7R SMD 0402 YES Murata GRM155R71H102KA01D

9 4 D1, D3, D4, D6 DIO LED GREEN 2V 30mA 35mcd Clear SMD 0603 YES Lite-On Inc LTST-C191KGKT

10 1 D2 DIO LED YELLOW 2.2V 25mA 3.4mcd Diffuse SMD 0603 YES Stanley Electric Co FY1111C-TR

11 1 D5 DIO TVS ARRAY RCLAMP0582BQTCT 5V 300W SMD 
SC-75-3

YES Semtech Corporation RCLAMP0582BQTCT

12 6 FB1, FB2, FB3, FB4, FB7, FB8 FERRITE 600mA 120R SMD 0603 YES TDK Corporation MMZ1608B121CTAH0

13 2 FB5, FB6 FERRITE 220R@100MHZ 2A SMD 0603 YES Murata Electronics North America BLM18EG221SN1D

14 1 J1 CON HDR-2.54 Female 1x2 Gold TH R/A DNP Sullins Connector Solutions PPPC021LGBN-RC

15 5 J2, J3, J5, J6, J11 CON HDR-2.54 Male 1x2 Gold 5.84MH TH VERT YES FCI 77311-118-02LF

16 1 J4 CON HDR-2.54 Male 1x5 Gold 5.84MH TH VERT DNP FCI 68000-105HLF

17 1 J7 CON MODULAR JACK RJ45 10/100 MAGNETICS 0xLEDs 
SHIELD TH R/A

YES Bel Fuse Inc. 08B1-1X1T-36-F

18 1 J8 CON JACK MINI50 2MM BLACK MALE TH R/A DNP Molex, LLC 0347930040

19 1 J9 CON TERMINAL 3.5mm 1x2 Female 16-28AWG 6A TH R/A YES On Shore Technology Inc ED555/2DS

20 2 J10, J13 CON HDR-2.54 Male 1x2 Gold 6.75MH TH R/A DNP Molex, LLC 0901210762

21 1 J12 CON USB2.0 MICRO-AB FEMALE SMD R/A YES Hirose ZX62-AB-5PA(31)

22 1 J14 CON HDR-1.27 Male 1x5 TH VERT YES Sullins Connector Solutions GRPB051VWVN-RC

23 1 L1 CM CHOKE 5.5R@100kHZ 200UH SMD 3.2X2.5MM YES TDK Corporation ACT1210L-201-2P-TL00

24 2 R1, R25 RES TKF 330R 1% 1/10W SMD 0603 YES Panasonic ERJ-3EKF3300V

25 2 R2, R32 RES TKF 1k 1% 1/10W SMD 0603 YES Panasonic ERJ-3EKF1001V

26 10 R3, R5, R26, R31, R35, R38, R44, 
R47, R48, R49

RES TF 1k 0.1% 1/16W SMD 0402 YES Yageo RT0402BRD071KL

27 1 R4 RES TKF 200k 1% 1/10W SMD 0603 YES Panasonic ERJ-3EKF2003V

28 6 R6, R7, R24, R27, R30, R52 RES TKF 10k 5% 1/16W SMD 0402 YES Vishay CRCW040210K0JNED

29 2 R8, R15 RES TF 1k 1% 1/2W SMD 1206 YES Stackpole Electronics Inc. RNCP1206FTD1K00

30 12 R9, R10, R11, R12, R13, R14, R16, 
R17, R20, R21, R22, R23

RES TKF 0R 1/16W SMD 0402 YES Yageo RC0402JR-070RL
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31 2 R18, R51 RES TKF 4.7k 1% 1/16W SMD 0402 DNP Yageo RC0402FR-074K7L

32 1 R19 RES TKF 100k 1% 1/4W SMD 0603 YES Vishay CRCW0603100KFKEAHP

33 2 R28, R29 RES TKF 2.2k 1% 1/10W SMD 0402 YES Panasonic ERJ-2RKF2201X

34 9 R33, R34, R37, R40, R41, R42, R43, 
R46, R50

RES TKF 4.7k 1% 1/16W SMD 0402 YES Yageo RC0402FR-074K7L

35 2 R36, R45 RES TkF 6.49K 0.1% 1/16W SMD 0402 YES Panasonic Electronic Compo-
nents

ERA-2ARB6491X

36 1 SW1 SWITCH TACT SPST 16V 50mA  PTS810 SJM 250 SMTR 
LFS SMD

YES C&K Components PTS810 SJM 250 SMTR LFS

37 1 TP1 CON TP LOOP Orange TH YES Keystone Electronics 5003

38 1 TP2 MISC, TEST POINT MULTI PURPOSE MINI BLACK YES Keystone 5001

39 1 U1 MCHP INTERFACE ETHERNET KSZ8081MNXIA QFN-32 YES Microchip Technology KSZ8081MNXIA-TR

40 1 U2 MCHP INTERFACE T1 ETHERNET LAN8770M QFN-32 YES Microchip Technology LAN8770M/PRA

41 1 U3 MCHP ANALOG LDO 3.3V MCP1725T-3302E/MC DFN-8 YES Microchip MCP1725T-3302E/MC

42 1 U4 MCHP MCU 8-BIT 48MHz 32kB 2kB PIC18LF25K50-I/ML 
QFN-28

YES Microchip Technology PIC18LF25K50-I/ML

43 2 Y1, Y2 CRYSTAL 25MHz 10pF SMD ABM8G YES Abracon LLC ABM8G-25.000MHZ-B4Y-T

TABLE B-1: EVB-LAN8770M_MC BILL OF MATERIALS (CONTINUED)
Item Qty Designator Description Populated Manufacturer Manufacturer Part Number
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EVB-LAN8770M_MC
EVALUATION BOARD

USER’S GUIDE

Appendix C. Silk Screens

C.1 INTRODUCTION
This appendix shows the top and bottom silk screen images of the EVB-LAN8770M_MC.

FIGURE C-1: EVB-LAN8770M_MC TOP SILK SCREEN IMAGE

FIGURE C-2: EVB-LAN8770M_MC BOTTOM SILK SCREEN IMAGE 
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EVALUATION BOARD
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Appendix D. PIC® MCU Programming

D.1 INTRODUCTION
The EVB-LAN8770M_MC has a PIC18LF25K50 microcontroller that initializes the LAN8770M at power-on, 
and provides user access to the registers via the USB interface. The PIC microcontroller is already 
programmed, so users are not expected to reprogram it. However, the following instructions are provided 
for users who wish to reprogram it with modified initialization code.

D.2 SETTING UP MPLAB® X IDE AND MPLAB® XC8 COMPILER
To set up the MPLAB X IDE and MPLAB XC8 Compiler:
1. Download the latest MPLAB X IDE (5.xx) from the Microchip X IDE website.
2. Open the installer. (In Windows, it will be in the Downloads directory.) Accept the license agreement 

and click Next on every step to launch the installation.
3. When installation is finished, additional items to install are prompted. For this, only the MPLAB XC8 

Compiler is necessary. See Figure D-1 for items to check and then click Finish. This opens a web 
page to the Microchip XC Compilers.

FIGURE D-1: MPLAB® X IDE SETUP WIZARD SCREEN

4. On the Microchip XC Compilers website, download the MPLAB XC8 Compiler.
5. Open the XC8 Compiler installer (same directory as in step 2). Accept the license agreement and click 

Next on every step of the installation.
6. Once the installation is complete, click Next (if activating a license, which is not necessary), activate 

your license, and then click Next.
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D.3 SETTING UP PROJECT IN MPLAB® X IDE
1. Open MPLAB X IDE.
2. Go to File>Open Project.
3. Navigate to the folder where UNG8187_TX_T1_Version_1_USB.X folder is located. Select it and 

click Open Project.

FIGURE D-2: UNG8187_TX_T1_VERSION_1_USB.X FOLDER NAVIGATION

4. The project for the 100BASETX to 100BASET1 PIC Program opens. Expand the project in the 
upper-left corner. The PIC microcontroller is programmed with the register read and write functions in 
the Initialize_LAN8770() function in the LAN8770.c file. Double click to open. The 
default programming in this function is to set the EVB-LAN8770M_MC to its best interoperability with 
other 100BASE-T1 link partners, but other read and write functions can be done after the default ini-
tialization.

FIGURE D-3: 100BASE-TX TO 100BASE-T1 PIC® PROGRAM PROJECT SCREEN
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D.4 PROGRAMMING THE PIC® MICROCONTROLLER
1. To program the PIC microcontroller, connect the programmer to J14 on the EVB-LAN8770M_MC, with 

pin 1 of J14 lining up with pin 1 of the programmer. 
Note: The programmer may have additional lines that are not connected to the J14 pins of the board, 

which are acceptable.
2. Go to Production>Set Project Configuration>Customize. The following window (Figure D-4) appears. 

Choose the Hardware Tool (PICKit3, PICKit4, and so on) and XC8 compiler. Click Apply and then 
click OK.

FIGURE D-4: PROJECT CONFIGURATION SCREEN

3. Click the green play button in the toolbar to program the PIC microcontroller (Figure D-5).

FIGURE D-5: PROGRAMMING BUTTON IN TOOLBAR
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This programs the PIC microcontroller. The bottom-right window will display the following messages as in 
Figure D-6 when the PIC programming is successful.

FIGURE D-6: PROGRAMMING CONFIRMATION

4. On the EVB-LAN8770M_MC, press the Reset button. This resets the PIC microcontroller, which then 
initializes the EVB-LAN8770M_MC registers.
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